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Abstract

The development of microbial communities depends on a combination of complex deterministic and stochastic factors that can dramatically alter
the spatial distribution and activities of community members. We have developed a microwell array platform that can be used to rapidly assemble
and track thousands of bacterial communities in parallel. This protocol highlights the utility of the platform and describes its use for optically
monitoring the development of simple, two-member communities within an ensemble of arrays within the platform. This demonstration uses two
mutants of Pseudomonas aeruginosa, part of a series of mutants developed to study Type VI secretion pathogenicity. Chromosomal inserts of
either mCherry or GFP genes facilitate the constitutive expression of fluorescent proteins with distinct emission wavelengths that can be used to
monitor community member abundance and location within each microwell. This protocol describes a detailed method for assembling mixtures of
bacteria into the wells of the array and using time-lapse fluorescence imaging and quantitative image analysis to measure the relative growth of
each member population over time. The seeding and assembly of the microwell platform, the imaging procedures necessary for the quantitative
analysis of microbial communities within the array, and the methods that can be used to reveal interactions between microbial species area all
discussed.

Video Link

The video component of this article can be found at https://www.jove.com/video/55701/

Introduction

Microbial communities are shaped by both deterministic factors, such as the structure of the environment, and stochastic processes, which
are associated with cell death, division, protein concentration, number of organelles, and mutation1. Within the natural environment, it can be
nearly impossible to parse the individual impact of these influences on community composition and activity. Obscured by natural structures and
buried within a chemical and biological milieu, identifying community members and further resolving their spatiotemporal distribution within the
natural environment is extremely challenging. Nonetheless, recent efforts have underscored the importance of spatial organization on community
function and point towards the need to account for both member abundance and organization in ongoing studies2,3,4.

It is clear that the local chemical environment (i.e. the availability of nutrients and secondary metabolites), the physical structure (e.g., soil
architecture, plant roots, ocean particles, or the intestinal microvilli), the presence or absence of oxygen, and the introduction of pathogenic
species all affect the composition, architecture, and function of microbial communities5,6,7,8,9,10,11. Nonetheless, traditional techniques for
cultures that neglect to capture these factors continue to prevail. Community composition (e.g., the presence of co-dependent species), physical
attachment, signaling molecule concentration, and direct cell-cell contact are all important factors for shaping a microbial community and can
be lost in conventional culture conditions. These properties are difficult to replicate in a bulk liquid culture or on an agar plate. The availability
of microfluidic, micropatterning, and nanofabrication techniques that allow for the replication of key physical and chemical features of natural
environments has, however, enabled many researchers to build bacterial communities to study their interactions12,13,14 and to develop synthetic
environments that mimic natural conditions4,15,16,17,18,19,20.

This protocol describes a method to fabricate a microwell array device and provides detailed experimental procedures that can be used to
functionalize the wells in the array and to grow bacteria, both as single-species colonies and in multi-member communities. This work also
demonstrates how bacteria modified to produce fluorescent reporter proteins can be used to monitor bacterial growth within wells over time. A
similar array was presented previously and showed that it is possible to track the growth of single-species colonies of Pseudomonas aeruginosa
(P. aeruginosa) in microwells. By modulating well size and seeding density, the starting conditions of thousands of growth experiments can be
varied in parallel to determine how the initial inoculation conditions affect the ability of the bacteria to grow21. The current work uses a slightly
modified version of the microwell array that builds on the previous work by enabling the simultaneous comparison of multiple arrays and by
using a more robust experimental protocol. The array used in this work contains multiple subarrays, or array ensembles, containing wells of
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different sizes, ranging from 15 - 100 µm in diameter, that are arranged at three different pitches (i.e. 2x, 3x, and 4x the well diameter). The
arrays are etched into silicon, and the growth of the bacteria seeded in the silicon arrays is enabled by sealing the arrays with a coverslip that
has been coated with a medium-infused agarose gel. P. aeruginosa mutants designed to study the Type VI secretion system are used in this
demonstration.

The results presented here build toward the ultimate goal of analyzing multimember communities within microwell arrays, enabling researchers
to monitor the abundance and organization of bacteria in situ while controlling and probing the chemical environment. This should ultimately
provide insights into the "rules" that govern community development and succession.

Protocol

1. Silicon Microwell-array Fabrication

1. Parylene coating
1. Deposit between 1-1.5 µm of parylene N on silicon wafers using a commercially available parylene coating system according to the

manufacturer's specifications and instructions (settings: vaporizer set point = 160 °C; furnace set point = 650 °C).
 

NOTE: Approximately 6 g of parylene N loaded into a chamber yields coatings 1-1.5 µm thick.

2. Photolithography
1. Spin-coat the parylene N-coated wafers with adhesion promoter, 20% hexamethyldisilazane (HMDS), and 80%propylene glycol

monomethyl ether acetate (PGMEA) (see the Table of Materials) at 3,000 rpm for 45 s. Fill a 2 mL transfer pipette with adhesion
promoter and sprinkle it over the entire wafer. Allow the wafer to sit for approximately 10 s before spinning it dry.

2. Fill a 2 mL transfer pipette with positive-tone photoresist (see the Table of Materials) and dispense the photoresist in the center of the
wafer. Spin at 3,000 rpm for 45 s to yield a resist coating that is approximately 1.5 µm thick.

3. Soft-bake the samples on a hotplate at 115 °C for 1 min.
4. Use a contact aligner and photomask with the desired well pattern to expose the sample to ultraviolet light. Expose the spin-coated

wafer through the patterned photomask for 6 s, giving an approximate dose of 60-80 mJ/cm2 measured at 365 nm.
5. Develop the pattern by submerging the sample in developer (< 3% tetramethyl ammonium hydroxide in water; see the Table of

Materials) for 2 min. Rinse with DI water and dry with clean, dry nitrogen.
 

NOTE: The areas of photoresist exposed to UV should be cleared during development.

3. Reactive ion etching
1. Use an oxygen plasma etch to remove the exposed parylene all the way to the silicon substrate.

 

NOTE: The recipe can be modulated to alter the etch rate of the parylene. For parylene thicknesses between 1 and 5 µm, use a recipe
with 60 mTorr, 20 °C, 100 sccm O2, 10 W RF, and 2,000 W ICP on a Reactive Ion Etching (RIE) tool. After etching and removing the
exposed parylene layer, the patterned area (i.e. the exposed silicon) should look shiny and silver.

2. Use a deep RIE (DRIE; e.g., Bosch DRIE) etch process to etch into the silicon.
 

NOTE: The etch rate and duration will determine the well depth. One full cycle of the Bosch process (a 3 s deposition step: 20 mTorr,
15 °C, 140 sccm C4 F8, 10 W RF, and 1,750 W ICP followed by a 10 s etch process: 20 mTorr, 15 °C, 120 sccm SF6, 8 W RF, and
1,750 W ICP) corresponds to approximately 1 µm of etch depth. The wells used in this demonstration range from 3 - 3.5 µm deep.

3. Verify the etch depth using physical profilometry.
1. Load the sample into a physical profilometer (see the Table of Materials).
2. Turn on the sample vacuum and press the manual load button.
3. Focus the system onto the sample by pressing the "Focus" button. Position an appropriate feature for measurement on the view

screen.
4. Scan the sample. Level the profile and measure the feature depth.
5. Record the etch rate and modulate subsequent etch times to achieve the desired depth.

 

NOTE: The measurements will include the depth of the silicon well, the thickness of deposited parylene, and the thickness of the
photoresist. Verifying the thickness of each layer throughout the procedure is necessary to achieve accurate well depth.

2. Bacterial Culture and Seeding (Figure 1a)

1. Start colonies on Luria Broth (LB) agar plates from glycerol stocks and use within two weeks. Pick colonies of the desired strains from LB
agar plates and start overnight cultures of P. aeruginosa. Incubate the overnight cultures for approximately 18 h at 37 °C while shaking at 220
rpm in R2A medium.
 

NOTE: Colonies should be picked within two weeks of plating to ensure that the mutations and fluorescent reporter genes are retained. All P.
aeruginosa work should be done under BSL-2 conditions.

2. Use a diamond scribe to section the silicon wafer into individual chips containing the ensembles of different sizes and pitch-well arrays.
Ensure that each chip contains the full complement of well sizes and pitches for the study.
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Figure 1: Fabrication and Cell Seeding Procedure. (a) Microwell arrays are etched into silicon wafers coated with a thin layer of parylene (i).
To wet the wells and/or functionalize the surface, a protein solution is added in a droplet on top of the arrays (ii). The protein solution is removed,
the wafers are dried, and a new solution containing the desired bacteria is added (iii). The bacterial solution is removed after an incubation
period, and the wafers are allowed to dry, leaving behind bacteria in the wells and on the surface (iv). The surface-associated bacteria are
removed with parylene lift-off, leaving behind bacteria seeded cleanly in the microwells and still viable due to the 2% glycerol medium, which
helps to keep the wells hydrated(v). The silicon chips are then placed array-side down on an agarose gel-coated glass coverslip, which feeds
bacterial growth in the microwells (vi). (b) Layout of sub-arrays on a single silicon device. Each sub-array contains a set of identical wells. The
diameter of the microwells across all sub-arrays range in diameter from 5-100 µm and are organized at 2x, 3x, or 4x the well diameter pitch,
which is denoted by the white to dark-gray colors on the bottom panel schematic. When the well depths are shallow (<10 µm), the 5 and 10 µm
well diameters are rarely useful, generally because of a lack of cells colonizing these very small wells. In this work, only the data from wells with
15-100 µm diameters were analyzed. Please click here to view a larger version of this figure.

NOTE: As shown in Figure 1b, a complete chip contains sub-arrays of wells, with diameters ranging from 5 to 100 µm, with three different
pitches (i.e. 2x, 3x, and 4x the diameter) repeating 4 times.

3. Place a 150 µL droplet of 500 µg/mL Bovine Serum Albumin (BSA) in PBS solution on top of the array to wet the microwells.
Incubate the BSA solution for 1 h on the chip at RT in a humid chamber.

1. Create the chamber by filling the bottom of an empty pipette tip box with Phosphate-Buffered Saline (PBS).
 

NOTE: Other substances, such as specific lectins, can be used in place of BSA to functionalize the surface of the microwells.

4. While incubating silicon chips with BSA solution, centrifuge the cultures at 2,500 rpm (corresponding to an average of 950 x g) for 5
min and then resuspend them in 500 µL of fresh R2A medium with 2% glycerol.

1. Determine the OD of the culture using a UV-vis spectrometer at 600 nm. Adjust it to an OD of 0.02 using 2% glycerol R2A medium.
 

NOTE: The glycerol helps to prevent the wells from drying out during parylene lift-off.

5. After incubation, remove the BSA solution and rinse 3x with PBS by removing and replacing the liquid droplet covering the silicon microwell
array. Dry under nitrogen.

6. Add 150 µL of 0.02 OD cultures to each of the dry arrays placed in a humid chamber. Incubate for 1 h at 4 °C to allow the bacteria to adhere
to the well walls.
 

NOTE: Refrigeration is not required for incubation. The 4 °C incubation time can be used to prevent the growth of bacteria before imaging
begins so that one can visualize the spatial organization of the communities prior to growth. Room-temperature incubation can also be used.
Both protocols result in similar growth curves.

3. Microscope Set-up

1. Prior to starting the bacterial incubation on the silicon chips, turn on the stage-top environmental control chamber (see the table of materials)
and adjust the settings on the control box so that the humidity (~100%) and temperature (30-32 °C, see step 3.2) can equilibrate prior to
adding samples.

2. Level the sample holder and line the interior around the sample with PBS-soaked lab wipes (see the Table of Materials) to increase
the humidity in the chamber to dew point. Set the temperature of the chamber to 30 °C and that of the chamber lid to 32 °C to reduce
condensation on the imaging plane.
 

NOTE: The slide holder fits into the live-cell chamber with a gasket that is approximately 1 cm thick. The sample holder is leveled with the
assistance of a bubble level that is placed on top of the sample holder. The sample holder can be tilted slightly and remain sealed in the
gasket to level.

3. While cultures are incubating on the silicon chips, manually turn on the power switch for the mercury lamp at least 30 min prior to imaging.
Manually turn on the camera and automated microscope stage. Open the software used to control the microscope and peripheral equipment
and ensure that the equipment is recognized by the software.
 

NOTE: Magnification is 10X with NA = 0.3.
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4. Preparation of Agarose-coated Glass Coverslips

1. Microwave previously prepared agarose solutions (i.e. 2% agarose in R2A medium) until a liquid state is reached, approximately 60 s.
2. Wet the back of a 75 mm x 22 mm, #1.5 glass coverslip with ethanol and place it lengthwise, centered, across a 2 x 3" (50 x 75 mm) glass

slide. Place two PDMS spacers (thickness of ~1 mm) along the long edges of the coverslip and shift the glass coverslip so that roughly 1 mm
of the coverslip is overhanging the edge of the slide.

3. Pour 5 mL of liquid agarose solution on top of the glass coverslip, just enough to completely cover it, and place a second 2 x 3" glass slide on
top of the assembly to "sandwich" the liquid agar between the coverslip and slide.
 

NOTE: This controls the depth of agarose, making the total thickness of the coverslip and hardened agarose equal in thickness to the PDMS
spacers.

4. Allow the glass slide-coverslip-agarose gel-glass slide sandwich to set until the agarose solution begins to solidify; then, transfer it to a
refrigerator. After 15 min, remove the excess solid agarose and cut around the glass coverslip. Move this to a clean dish and place it in a
refrigerator until use.

5. Sealing the Wells with an Agarose-coated Coverslip and Imaging

1. After the bacteria incubation period is complete, remove the agarose-coated coverslip from the refrigerator and prepare the silicon
chips, as follows.

1. Dip the silicon chips in ultrapure water, one at a time, for 10 s each. Set them on their edges on a lab wipe or tissue until most of the
excess liquid has drained from the edges of the chips.

2. Cut a piece of tape to match the edge length of each silicon chip. Place the tape on the parylene that is covering the silicon and use it
to quickly peel away the parylene coating.

3. Immediately invert each peeled chip and place each chip such that the microwell-array side faces (and makes contact with) the
agarose-coated side of an agarose-coated coverslip. Take care not to move or shift the chip after it touches the agarose to prevent the
growth of bacteria outside of the wells.

2. Place the assembled microwell array/agarose coverslip in the slide holder of the stage-top environmental control chamber on the
miscroscope.

1. Use ambient light or directed light (e.g., a flashlight) to locate arrays of interest. Use the commercial software controlling the automated
stage to save those positions (see the table of materials). Turn off ambient or directed light after the positions are stored.

2. In the commercial software, open the "ND Acquisition" panel.
 

NOTE: This panel includes a menu for automatic saving to a specific directory, as well as programmable image acquisition. For these
experiments, the "Time," "XY," and "λ" menus are used.

3. To save the locations in the software, click on the "XY menu" and then check an empty box on the left-hand side for each position that
needs to be saved. Also, click on the "Include Z" button.

3. Acquire images over time at the desired wavelengths and 10 magnification using the appropriate fluorescence filter cubes (see the
Table of Materials).

1. Use the control software and saved array positions to move to each saved location and to focus on the wells. Click on each XY location
in the saved list and adjust the focus using the Green Flourescence Protein (GFP) filter. Save the new z-position by clicking the arrow
pointing at the z-location.
 

NOTE: This process can be time-consuming. Consider taking the precaution of increasing the gain and using the neutral density filter
to reduce the light intensity to prevent photobleaching.

2. Determine the z-axis distance between focal planes for each wavelength by noting the difference in the z-axis position when focused
on the surface of the array. Choose 2-3 locations from the array with the mixed red/green bacteria population and focus using the Red
Fluorescence Protein (RFP) filter.

1. Subtract the distance between the focal planes using the GFP and RFP fluorescence filters and add that focal plane adjustment
under the "λ" menu.
 

NOTE: For example, if the array appears focused in the GFP channel at a z-location of 50 µm, and the same array appears
focused in the RFP channel at 55 µm, add +5 next to the RFP optical configuration in the "λ" menu.

3. Begin time-lapse image acquisition.
 

NOTE: For the experiments shown here, RFP and GFP images were acquired for every array position at 30 min intervals using multi-
dimension image acquisition through a commercial software that controls the camera, shutter, filter wheel, and motorized stage.

1. Set the "interval" to 30 min and the "duration of the experiment" to 24 h under the "Time" menu. Click "Run Now."
 

NOTE: With the "Time," "XY," and "λ" boxes checked, running the program will move the stage to image each location (i.e. the
saved XYZ locations), take an image in one wavelength, move the z-position to account for focal plane differences (i.e., lambda
or wavelength control), take the second image, move on to the next array location (multipoint), and loop this at 30 min intervals
(time-lapse).

4. Acquire illumination control images.
 

NOTE: Use the "ND Acquisition," "Time," and "XY" menus to take images of 4 locations, 25x each.
1. Take a series of 100 "darkfield" images by turning off all light sources and taking an "image" of a standard slide. These images will

capture camera noise. Use the longest exposure time used during the timelapse (step 5.3.3).
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2. Take a series of 100 "illumination field" images by imaging a standard slide (i.e. uniform RFP or GFP intensity) at a few different
locations to capture the uneven illumination at the given experimental conditions. Choose an exposure time that maximizes the signal
without reaching saturation.

6. Analysis

1. Process the image stacks using an image analysis software (e.g., ImageJ).
1. Convert the acquired images to tiff file format using the commercial software. Upload images into the image analysis software by

clicking "File"> "Import"> "Image Sequence."
2. Create a "Correction Image" by averaging all "darkfield" and "illumination field" images. Subtract the average "darkfield" image from

the average "illumination field" image by choosing "Process" > "Image Calculator." Select the two images, "Image1" and "Image2," and
then "Subtract" in the "Operation" field. Click "OK."

1. For averaging, load the correction (or darkfield) images, click "Image" > "Stacks" > "Z Project" > "Average Projection."

3. Perform image registration if necessary. Then, perform background subtraction by clicking "Process" > "Subtract Background." Enter a
radius (e.g., 125) in the "radius" field and select "sliding paraboloid."

4. Perform illumination correction using "Process" > "Calculator Plus." Choose the following parameters: operation, divide; i1, well image;
i2, correction image; k1, correction image mean; and k2, 0. Click "Create New Window."
 

NOTE: This data set did not require registration, but in other work, the ImageJ Plugin StackReg was used with the "Translation"
transformation. For the background subtraction, use the same sliding paraboloid radius for every image set. For example, if the largest
wells imaged have a pixel radius of 100, use a radius larger than 100 (e.g., 125) for every image set.

2. Determine the growth of each strain in the microwells.
1. Select regions of interest (ROIs) around each microwell in the desired arrays using the ImageJ "MicroArray" plugin.

1. In the "MAP" menu, click "Reset Grid." Specify rows, columns, and diameter (based on the well size and number on the array;
see Figure 1b). Select "circle" from the "ROI shape" menu.

2. Hold the "Alt" key while selecting the top-left ROI with the mouse to move the ROI array. Hold the "shift" key while selecting the
bottom-left ROI to change the size of the array. Hold the "shift" key while selecting an ROI from the right side of the array, but not
at the corners, to change the spacing of the ROIs.

3. Use the above commands to fit the ROI array over the wells in an image. Click "Measure RT."
 

NOTE: The plugin will export the desired measurements from each ROI. Use three ROI sizes, creating concentric rings
around the wells to collect local the background signal (i.e., the signal from the middle ring subtracted from the outer ring) and
fluorescence measurements (i.e., the signal from the inner ring).

2. Collect the data in a spreadsheet software and calculate the background signal. Import it to a custom scripting software for further
analysis.

3. Data organization and analysis
1. Import the data and organize the data collected in ImageJ into a matrix in the following order for all times: column 1, sub-array number;

column 2, well row; column 3, well column; column 4, mean intensity; column 5, background intensity; and column 6, mean intensity -
background intensity.

1. Separate the results of the mCherry and GFP acquisition into different matrices. Store the results from each sub-array and each
color in a different cell in a cell array.
 

NOTE: This organization makes it simpler to move back and forth between image data and measurement results, cleaning the
data and ensuring that the measurements accurately represent the data.

2. Adjust for the autofluorescence of P. aeruginosa.
 

NOTE: In experiments involving the co-culture of GFP and mCherry strains, an mCherry-only chip should be analyzed to ascertain the
relationship between mCherry and green autofluorescence.

1. Plot the mCherry-versus-GFP signal from all mCherry ΔretSΔtse/i1-6 wells at all time-points to determine the relationship
between the mCherry signal and the autofluorescence in the GFP channel. Subtract the autofluorescence signal from the co-
cultures.

3. Plot the trajectories and fit a modified logistic equation to each trajectory to extract parameters using least squares fitting in either a
spreadsheet software or a custom scripting software.

4. Look for correlations between and among GFP and mCherry trajectory parameters.

Representative Results

The experimental platform presented here is designed for high-throughput and high-content studies of bacterial communities. The design
enables thousands of communities, growing in wells of various sizes, to be analyzed simultaneously. With this microwell array design, the
dependence of the final community composition on initial seeding densities, well size, and chemical environment can be determined. This work
demonstrates the growth of a two-member community in the microwell array and puts forth methods to analyze community composition and
organization.
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The model system used here was designed in the Mougous lab to study Type VI secretion in P. aeruginosa. The system is composed of several
mutant strains, containing either GFP or mCherry fluorescent reporters. In this work used 2 different strains. The first is a GFP-labeled ΔretS
mutant that constitutively expresses the toxic effector proteins associated with Type VI secretion, resulting in higher levels of cell death in
susceptible cells. The second is an RFP-labeled ΔretSΔtse/i1-6 strain that is a deletion mutant missing all six known effector proteins and that
has been shown to be more susceptible to Type VI pathogenesis22,23,24. The growth trajectories of each species were tracked individually and
within two member communities (i.e. co-culture within the array platform).

The ΔretS and ΔretSΔtse/i1-6 mutants were seeded onto three arrays, each separately and also mixed together in a 1:2 ratio, and then imaged
every 30 min for 20 h. Bacterial growth in the wells ceased between 6 & 12 h postseeding. Examples of the fluorescent image data are shown
in Figures 2 and 3. Figure 2 shows growth over time of the ΔretS and ΔretSΔtse/i1-6 strains in 45 µm diameter wells, and Figure 3 shows the
state of these same two-member communities about 6 h postseeding (hps) in wells of various sizes.

 

Figure 2: Sample Images from a Time-course co-culture Growth Experiment. Two mutants of P. aeruginosa, expressing either mCherry
(ΔretSΔtse/i1-6) (red) or GFP (ΔretS) (green), are seeded together in a 2:1 mCherry:GFP ratio in the microwell arrays. Pictured here are
composite images taken at 3 different times postseeding in the 45 µm diameter wells. Please click here to view a larger version of this figure.

 

Figure 3: Range of Well Diameters Included in the Microwell Array Device. Representative images of two-member communities captured at
8 h of growth. Generally, mCherry (ΔretSΔtse/i1-6) (red) or GFP (ΔretS) (green) colonies show minimal colocalization, remaining within distinct
areas in the microwells. Please click here to view a larger version of this figure.
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Prior to the acquisition of the measurements, a sliding parabaloid background subtraction was performed. An illumination correction step was
employed so that the signal from each microwell imaged in a given experiment could be compared quantitatively. These methods have been
previously described25. Using the microarray plugin in ImageJ, the average intensity of the red and green bacteria was measured in the corrected
images, along with a local background signal. The local background signal was subtracted from the well signal, and the GFP signal was adjusted
to correct for the autofluorescence of P. aeruginosa co-cultures (autofluorescence determined from mCherry ΔretSΔtse/i1-6-only arrays). Once
all these corrections were performed, the quantitative growth trajectories of mCherry- and GFP-expressing bacteria could be plotted. Example
growth trajectories from 20 and 50 µm diameter wells are shown in Figure 4.

 

Figure 4: Growth Curves of Mono- and Co-cultures of P. aeruginosa Type VI Secretion Mutants. (a and d) GFP-ΔretS monoculture
growth curves in 20-µm and 50-µm wells, respectively. (b and e) mCherry-ΔretSΔtse/i1-6 monoculture growth curves in 20 and 50 µm wells,
respectively. (c and f) Co-culture of a 1:2 ratio mixture of GFP (green) and mCherry (red) P. aeruginosa strains. Growth curves are plotted from
when image acquisition began, approximately 2 h postseeding (hps). Please click here to view a larger version of this figure.

The growth trajectories from the mono- and co-culture of P. aeruginosa strains indicate that there is some variability in growth from well to
well and that this variability is increased in wells of smaller dimensions. However, the mean intensity is not significantly affected by well size.
There does not appear to be a dramatic or clear negative effect on the growth of the susceptible strain (ΔretSΔtse/i1-6) when the ΔretS strain
is present. The overall intensity for each strain decreased, but this was due to a lower starting concentration of each strain in the wells, as the
total OD was kept consistent across experiments, not the individual OD of each strain. However, it is difficult to determine what factors are most
important to understanding the growth of bacteria in these wells simply by looking at growth trajectories alone. Therefore, each trajectory was fit
with a modified logistic function26 (Figure 5a) so that relevant parameters could be extracted and used to analyze bacterial growth data. Each
trajectory was transformed by taking the natural log of the signal divided by the initial signal. A modified logistic function, with three parameters
corresponding to a maximum signal (A), a maximum rate (µ), and a lag time (τ), was used to fit each trajectory.

Given the known interaction between the GFP-ΔretS and mCherry-ΔretSΔtse/i1-6 strains, one might hypothesize that the growth of the mCherry
strain would be inhibited in co-cultures with the GFP-ΔretS strain22,24. Using the extracted parameters, it is possible to look for positive or
negative correlations between the parameters extracted from GFP and mCherry trajectories. The initial parameter analysis suggested that the
co-culture of these species had a negligible effect on their overall growth. The variability seen in the growth curves is likely due to environmental
factors, such as initial seeding density, which becomes more variable at smaller well diameters (Figure 5b). Significant negative effects on the
mCherry strain due to the presence of GFP-ΔretS were not observed. For example, when plotting the maximum mCherry signal versus the ratio
of the initial GFP-to-RFP signal, no decrease in mCherry expression was found when there was a higher ratio of GFP-ΔretS in the wells.
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Figure 5: Fluorescent Growth Trajectories Fit with a Modified Logistic Equation. (a) The example curve is normalized and then fit with a
modified logistic equation by adjusting three parameters, a maximum intensity (A), a maximum rate (µ), and a lag time (τ). (b) Initial mCherry
signal versus initial GFP signal in individual wells of various diameters. (c) The maximum mCherry reporter signal plotted versus the ratio of the
initial intensity of the GFP-expressing bacteria to the RFP-expressing bacteria. Please click here to view a larger version of this figure.

Previous work in the Mougous lab indicated that the effects of Type VI secretion require direct cell-to-cell contact between secreting and
susceptible cells and that a longer contact period results in more cell lysis23. Therefore, we believe that, in these arrays, the exponential
growth of the two mutants is simply out-pacing the contact-mediated pathogenic effects in this model system. However, in wells of all sizes, the
GFP- and mCherry-expressing bacteria grow in distinct patches (Figures 2 and 3). Therefore, rather than focusing on growth rates, bacterial
communities containing contact-mediated pathogenic actors may be better studied using spatial analyses. For example, rather than focusing on
the integrated intensity, which is representative of the total number of red or green cells in a well, this microwell format allows for the number and
location of red and/or green pixels to be counted. It is possible to analyze the growth of individual colonies or patches within these wells, focusing
on the borders where the red and green signals overlap (Figure 6a). Quantifying co-localization events and nearest-neighbor analyses can then
be executed to look more closely at properties like patch size, patch growth rate, and patch overlap within individual wells. Spatial analyses
would be aided by higher-magnification imaging and confocal microscopy (Figure 6b).

 

Figure 6: The Spatial Organization of Different Species may be Analyzed using Epifluorescent and Confocal Microscopy. (a) Series of
images from one 100 µm well acquired using a confocal microscope with 20X magnification and NA of 0.8. The white arrows point toward yellow
regions where red and green colonies overlap or are mixed. Analyzing how the colonies grow in these regions would be interesting for studying
contact-based pathogenesis. (b and c) Confocal images (20X magnification, NA = 0.8) of 15 µm diameter, ~7.5 µm deep wells. Please click here
to view a larger version of this figure.

Discussion

This article presented a microwell array device and experimental protocols designed to enable high-throughput and high-content live-cell
imaging-based analysis of bacterial community development. While the focus of the demonstration here was to study the effects of contact-
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mediated Type VI secretion on community development, the arrays were designed to be flexible and accommodate the study of a broad range
of microbial communities and microbe-microbe interactions. The work here focuses solely on the use of bacteria that constitutively express
fluorescent markers to allow facile tracking of member abundance and location. However, opportunities to sample biological material from
individual wells following growth or perturbation by changing the chemical environment could, in principal, be used to identify community
composition and gene expression.

Each silicon device is composed of dozens of arrays containing microwells with various well diameters, organized at either a 2x, 3x, or 4x
diameter pitch, and etched to a depth between 3 & 3.5 µm. Because nutrients and secondary metabolites can diffuse freely through and
across the agarose lid, different pitch sub-arrays were included to allow for the examination of how signaling between microwells or local
nutrient depletion impact community development. In this demonstration, growth and community development did not appear to be impacted
by microwell spacing or location within the arrays. The shallow depth was chosen to simplify image analysis, limiting all microbial growth and
development to a single image plane. However, deeper wells (20 µm deep) have been used previously and can be easily modulated in depth
by varying the duration of the silicon etching process. Increasing the aspect ratio of the wells essentially alters the degree of confinement
experienced by the cells in the interior of the wells, effectively changing the ratio of the total well volume to the area through which nutrients
diffuse into the top of the well. This variety of array configurations could be used to study the effects of well-to-well or intra-well signaling.

One limitation of using silicon to fabricate the microwells is that it is opaque to visible light. Consequently, routine analyses that rely on
transmission of light (e.g., brightfield, phase, or differential interference contrast imaging) cannot be used to monitor growth. Ongoing research
and development in our group has focused on adapting this silicon microwell configuration and experimental protocol for work with transparent
arrays to allow for higher-resolution fluorescence and brightfield imaging for monitoring and quantification27. By using transparent materials
for fabrication, such as SU-8 epoxy on a glass coverslip, it is possible to acquire both brightfield and fluorescence images with objectives
operating at shorter working distances. This allows for more optimal resolution to be obtained with water immersion or oil objectives having ≥40X
magnification, without the difficulty of imaging through an agar layer, as is the case for silicon arrays.

As described in our prior work, seeding conditions and well geometry impact the seeding of cells within the well arrays. At low seeding densities
or in small wells, high levels of variation in the number and types of cells that load into individual wells allows for a broad and rapid exploration of
experimental parameter space. Higher seeding densities and/or imaging larger wells yields more consistent ratios of cell types and total inoculum
levels, allowing for the analysis of large numbers of experimental replicates. A quick look at images during the earliest stages of growth suggests
that cells attach and grow primarily along the edges of the wells (Figure 5a). It is not clear if this is an artifact related to some evaporative drying
during the seeding process or suggests a preference for cell attachment to multiple edges. Intentionally altering the topography or surface
chemistry of the wells in a deterministic manner could reveal which factors have the greatest impact on cell attachment and biofilm formation.

Growth of the bacteria in these wells is supported by the use of an agarose gel-coated glass coverslip infused with R2A medium. The methods
described to create this agarose-coated coverslip ensure an even thickness through which to image and a fairly constant z-position, allowing
for the possibility to simultaneously image multiple silicon chips. The use of ultra-pure agarose as the gelling agent and a minimal medium
rather than a complete medium results in a cleaner, less autofluorescent background, increasing the overall signal-to-noise ratio. When relying
on fluorescence for the quantitative tracking of microbial communities, it is essential to keep imaging conditions consistent and to be acutely
aware of contributions from autofluorescence, photobleaching, and non-uniform illumination. In addition, for experiments requiring long time-
lapse image acquisition, a thick layer of agarose, such as used here, is desired. Thinner layers (~100 µm thick) can be made to enable higher
magnification imaging. However, it is difficult to keep the assembly humid enough to prevent that thin layer from drying out.

Though the initial analysis of growth parameters and initial inoculum levels has not yet revealed any significant correlations for the simple system
described here, the protocols and data shown emphasize the depth of information that can be extracted from images of community development
over time. Spatial organization within the wells evolves as single-species colonies expand from initial "nucleation" sites. Thus, factors associated
with the initial attachment density (i.e. stemming perhaps from the greater preference of one species for the well surface compared to another) or
growth rate of individual patches could dramatically influence community development. Subtler interactions, such as those mediated by contact
between species (patches) established very late in the growth process may require more in-depth analysis of the image data.

The microwell array platform and protocol presented here facilitate the rapid assembly and high-content analysis of microbial community
development and microbe-microbe interactions. Future work that allows for the control of the local chemical environment, by changing the
composition of medium within the agar lid or by directly modulating and sampling via integrated microfluidics, should allow for experimental
protocols that move beyond mimicking natural confinement and niche size and begin to explore the impact of dynamically changing
environments, similar to those found in nature. Future work will augment the array design with integrated microfluidics that can be used to
dynamically modulate the local chemical environment and to sample fluid from individual wells. Additional work on the development of optically
clear microwell arrays that can be used for higher-resolution and brightfield tracking of community growth has been described elsewhere27.
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